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Preface
Computer	 :	 Computers is a comprehensive series of eight books designed specifically 

for the needs and requirements of the students studying in classes 1-8.  This 
series perfectly complies with the NCERT syllabus criteria and the National 
Curriculum Framework's vision. In keeping with NEP 2020’s guidelines, the 
series adopts an interactive approach to make it possible for the learners to 
enjoy computers.  This book includes enough questions in accordance with 
the NEP criteria. The fundamental principles of NEP which are recognizing, 
identifying and fostering the unique capabilities of each student, respect 
for diversity, and consideration for the local context in all topics, are always 
kept in mind while framing the book.

		  The topics are introduced in a way that children experience and learn 
through exploration.

		  Child-friendly language and contextual images have been incorporated 
throughout the series to make the material more understandable for young 
readers. This allows them to connect what they read and relate it  to the 
views, ideas, and experiences they encounter every day.

Salient Features of the series:

Learning Outcomes	 :	 It guides both the teacher and the students towards the correct direction 
of efficient learning. It establishes the path of learning for efficient and 
superior learning results.

Warm Up	 :	 Children can connect their prior knowledge to the chapter's topic through 
simple yet engaging activities.

Teacher’s note 	 :	 An outline of guidelines for teachers to follow in the classroom in order to 
make lessons interactive and discussion-based.

Let me answer	 :	 Questions related to the topic which are  essential for checking pupil 
understanding and keeping them engaged with the task at hand.

Do You know	 :	 An interesting piece of information related to the topic.

Remember It 	 :	 Additional information about the topic to encourage children to wonder 
about various surroundings.

Kids’ IQ 	 :	 These questions have been included to reinforce learners to think,analyse 
and apply.

Up skill your 

Intelligence	 : 	 Ample exercises with a range of questions to support learning.

Critical Thinking	 :	 Questions which allow the learners to think clearly and rationally. 

Team Work 	 :	 It enables the students to collaborate with others.

		  The content is structured and well graded. Sincere efforts have been made 
to prevent any inconsistencies and make this series a perfect complement 
to the students' education. Any worthwhile recommendations for the 
improvement of the series are always welcome and greatly appreciated.

								          	   Author



             

             

             

FOCUS areas   of NEP 2020
It shows the right path of learning 
to the teacher as well as students. It 
establishes the direction of learning 
for efficient and superior learning 
results.

Children can connect their prior 
knowledge to the chapter's topic 
through simple yet engaging 
activities.

An outline of guidelines 
for teachers to follow in 
the classroom in order to 
make lessons interactive 
and discussion-based.

Additional information about the 
topic to encourage children to wonder 
about various surroundings.

It aids in providing a brief summary 
of the entire chapter.

Learning Outcomes Warm-Up

Teacher’s Note:

Remember It

Let's Recall

These questions have been included 
to reinforce learners to think,analyse 
and apply.

Kids' IQ



             

             

             

FOCUS areas   of NEP 2020
An interesting piece of information 
related to the topic. Questions which allow the learners 

to think clearly and rationally.

Questions related to the 
topic which are  essential 
for checking pupil 
understanding and keeping 
them engaged with the task 
at hand.

Do You Know
Critical Thinking

It enables the students to collaborate 
with others.

Team Work

Let me Answer

Ample exercises with a range of questions to 
support learning.

Upskill Your Intelligence
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Evolution of Computers

At the end of this chapter, the students will be able to:
)) Learn about varieties of calculating devices.
)) Comprehend the difference between various calculating devices.
)) Explain the evolution of computers.

Learning Outcomes

Warm-up
Look at the pictures carefully and circle the pictures which do calculations.

Teacher’s 
Note: Apprise students that earlier, computers were only designed to act like calculating devices.

1
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Over the past few decades, computers have undergone significant 
advances. Many years ago, in their most basic form, computers were 
very huge and slow. Computers have evolved over time to become faster 
smaller and more compact. For e.g. Earlier, Abacus helped people to do 
calculations and now, computers are envisioned to perform this task. 

Calculating devices have been developing ever since, giving rise to the 
potent computers we have today.

 Abacus

The abacus is considered to have been the 
earliest mechanical calculator. It was used 
to rapidly and easily conduct addition 
and subtraction.

An Abacus is made up of a wooden 
frame with rods, each having beads. 
It is divided into two parts called 
‘Heaven’ - the upper part and 
‘Earth’ - the lower part. By carefully 
positioning the beads, any number 
can be displayed.

“Hey Friends! We have already 
covered the components of computers 
in the previous class. Now, let’s learn 
about the changes that computers 
have undergone over time.”

Do You Know?
Abacus is also called a counting frame.

Let Me Answer
Have you ever done calculation 
using an abacus?

Figure 1.1: Abacus
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 Napier’s Bones

John Napier of Scotland invented Napier’s 
bones in 1617, a manually driven calculator for 
calculating products and quotients of numbers. 
It made the method of multiplication simple 
and also increased the speed of performing 
multiplication. This reduced the risk of error in 
large multiplication problems. This instrument 
was more compact than the earlier creations.

 Arithmetic Machine
Blaise Pascal created the mechanical calculator 
known as Pascal’s calculator, often referred to as 
the arithmetic machine or Pascaline, in 1642. It 
represents the position of digits with the help of 
gears in it. 
Pascal designed the machine to add and subtract two numbers directly 
and to perform multiplication and division through repeated addition 
or subtraction.

 Stepped Reckoner
German scientist, Gottfried Wilhelm Leibniz, 
started the creation of the Stepped Reckoner, 
sometimes referred to as the Leibniz 
calculator, in 1672 and finished it in 1694. 
The machine performs the basic operation of 
adding and subtracting as well 
as multiplication by repeated 
addition, and division by 
repeated subtraction.

Figure 1.2: Napier’s Bones

Figure 1.3: Pascaline

Figure 1.4: Stepped Reckoner

Sir Charles Babbage is also known as the 
‘ Father of the computer.’

Remember it!
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 Analytical Engine
English mathematician and computer pioneer, 
Charles Babbage,  created a mechanical general-
purpose computer called the Analytical Engine. It 
could perform any type of calculations. It had four 
different components or parts. These components are 
the reader, the store, the mill, and the printer which are 
essential components of every computer, even today.

 Tabulating Machine
Tabulating Machine was invented by an 
American Statistician, Herman Hollerith. This 
machine had the ability to read and process 
the data, further giving the desired output. 
Punch cards were used to give the inputs.

 ENIAC
Invented by American physicist John Mauchly 
and American engineer J. Presper Eckert in 
1946, ENIAC was the first programmable, 
electronic, general-purpose digital computer. 
These features were available on other 
computers, but the ENIAC offered them all 
in one convenient package. It could solve “a 
vast category of numerical problems” through reprogramming.

 UNIVAC I
UNIVAC I stands for Universal Automatic Computer I. 
It was the first commercially available general-purpose 
electronic digital computer designed in the United States 
for business applications.

Figure 1.5: Analytical Engine

Figure 1.6: Tabulating Machine

Figure 1.7: ENIAC

Figure 1.8: UNIVAC-I

Let Me Answer
Who is the ‘Father of the 
Computer’? Discuss.
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Figure 1.9: Harvard Mark-I

 Harvard MARK I
Howard Aiken at Harvard University and IBM 
developed the Harvard Mark I in 1944. It is 
also referred to as the Automatic Sequence 
Controlled Calculator. 
It was a general-purpose electromechanical computer. It also provided 
vital calculations for the U.S. Navy during World War II. One of the 
earliest programs to run on the MARK I was initiated on 29th March 
1944 by John Von Neumann.

Kids’ IQ
Arrange the following devices in descending order according to  their year of 
invention.

Let’s Recall
•	 The abacus is considered to have been the earliest mechanical calculator.
•	 Blaise Pascal created the mechanical calculator known as Pascal’s calculator.
•	 John Napier of Scotland invented Napier’s bones, a manually driven calculator.
•	 Charles Babbage created a mechanical general-purpose computer called the 

Analytical Engine.
•	 UNIVAC I stands for Universal Automatic Computer I. 
•	 ENIAC was invented by John Mauchly and J. Presper Eckert, in 1946. 
•	 Howard Aiken of Harvard University and IBM developed the Harvard Mark 

I in 1944.
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Upskill Your Intelligence

A.	 Fill in the blanks

	 1.	 Abacus is divided into two parts called ‘ .................... ’ - the upper part 
and ‘ .................... ’ - the lower part.

	 2.	 Over the past few decades, computers have undergone significant 
.....................

	 3.	 UNIVAC I stands for .....................

	 4.	 Charles Babbage created a mechanical general-purpose computer called 
the .....................

	 5.	  One of the early programs to run on the MARK I was initiated by 
.....................

B.	 Answer the following questions.

	 1.	 State the features of the Abacus.
		  ...........................................................................................................................
		  ...........................................................................................................................

	 2.	 List any two differences between Arithematic Machine and Napier’s 
Bones.

		  ...........................................................................................................................
		  ...........................................................................................................................

	 3.	 Who invented Stepped Reckoner?
		  ...........................................................................................................................
		  ...........................................................................................................................

	 4.	 State any similarity between ENIAC and UNIVAC I.
		  ...........................................................................................................................
		  ...........................................................................................................................
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	 5.	 State any two features of Harvard Mark I.
		  ...........................................................................................................................
		  ...........................................................................................................................

C.	M atch the following.
	 1.	 1642			   ENIAC
	 2.	 1617			   Harvard Mark I
	 3.	 1694			   Pascaline
	 4.	 1646			   Napier’s Bones
	 5.	 1944			   Stepped Reckoner

D.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 Abacus is also called a counting frame.	
	 2.	 Analytical Engine had four different components. 	
	 3.	 John Napier created the Stepped Reckoner.	
	 4.	 Sir Charles Babbage is also known as the Father of the Computer.	
	 5.	 Punch cards were used to give the outputs in Tabulating Machine.	

E.	 Tick the correct answers.
	 1.	 The Mill, Store, Reader, and Printer are components of the .....................
		    a. Napier’s Bones			     b. Arithmetic Machine
		    c.	 Abacus				      d. Analytical Engine
	 2.	 .................... was designed in the United States for business application.
		    a.	 UNIVAC I			     b. Tabulating Machine
		    c. MARK I				      c. Pascaline
	 3.	 Tabulating Machine was invented by .....................
		    a.	 Charles Babbage		    b. Blaise Pascal
		    c. Herman Hollerith		   c. Leibniz
	 4.	 Which calculator represents the position of digits with the help of gears 

in it?
		    a.	 Pascaline 	   b. Abacus	   c. ENIAC	   d. UNIVAC 
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I
	 5.	 One of the early programs to run on the MARK I was initiated on ............
		    a. 29th April 1943			     b. 29th March 1944
		    c. 27 March 1944			    d. 21 May 1956

Critical Thinking

A.	 Rahul is taking his exam and he is stuck on the question which says, Tell the 
name of the calculating device which was invented by a German scientist 
in 1694. Help him to find the answer. Give reasons.

	 ....................................................................................................................................
	 ....................................................................................................................................
	 ....................................................................................................................................

B.	 Unjumble the following devices:
	 1.	 ANIEC	 -	 .......................................................
	 2.	 ELAASCNPI	 -	 .......................................................
	 3.	 PNREIA  EBSON	 -	 .......................................................

Team Work

	 With the help of your Maths teacher, use the Abacus for doing mathematical 
calculations. Discuss the benefits of using an Abacus. Further, label the 
parts of the given Abacus.
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Organising Files and 
Folders

2

Warm-up

Reena wants to organise the things in proper storage. Help her by matching 
the objects with their appropriate storage.

At the end of this chapter, the students will be able to:
)) Manage files and folders using Windows 10.
)) Create a folder.
)) Rename, delete and restore a File and Folder,

Learning Outcomes

Teacher’s 
Note:

Inform students how we keep or arrange our items in our room. Similarly to this, we can 
use files and folders to keep our data on computers.
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“Hi Friends! Let’s learn how to 
keep our data in files and folders 
on computers.

We make files and folders which make it easier for us to remember where 
we have stored our work. Let us learn how to manage files and folders 
using Windows 10.

 ATTRIBUTES OF WINDOWS 10
ˡˡ In Windows 10, multiple users can work on one computer system at 

the same time.
ˡˡ The search tool of Windows 10 is called Cortana which lets us search 

for any information on the system or on the internet directly.
ˡˡ It also provides the feature of downloading free and paid apps from 

an application called the Microsoft Store.
ˡˡ We can open numerous desktops simultaneously 

by using the task view button.
ˡˡ The snap feature allows us to drag and drop a 

window to a corner of the screen, thereby making 
space for the other application.

ˡˡ It enables to start more than one program at a time.

Figure 2.1: 
Windows Logo

Do You Know?
Cortana interacts naturally via talking or typing and 
provides relevant recommendations, quick access to 
information, better searches and important reminders.

Let Me Answer
Which is the most commonly 
used operating system developed 
by Microsoft Corporation?
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 Files
A file is a collection of data or 
information. When you save your work 
in a program, it is saved as a file. Files 
are represented on computers by icons. 
The Windows 10 operating system allows us to generate many file types. 
The type of file can be recognised by its icon.

 folders

A folder serves as storage for files 
or other folders. A folder within a 
folder is called a Sub-folder. We can 
create any number of folders where 
each can hold any number of files 
and subfolders.

 Creating a folder

Follow the given steps to create a folder.
Steps: 

ˡˡ Go to the location where you want to create the 
folder.

ˡˡ Right-click on a blank space. 
ˡˡ Select New Folder from the contextual menu.
ˡˡ Windows will create the new folder at your current location.
ˡˡ Enter your desired folder name and press enter.

Shortcut Keys Combination: Press Ctrl + Shift + N key combination to create a new folder.

Word File PowerPoint 
File

Picture 
File

Pictures 
Folder

Desktop 
Folder

Documents 
Folder

Figure 2.2:  
Creating a Folder
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 File Explorer Window

File Explorer window 
provides comprehensive 
details of the drives, files, 
and folders that are present 
in our system. In this 
window, we can also create, 
open, move, or remove a 
folder.

 Opening File Explorer

Follow the given steps to 
open File Explorer
Steps:
1.	 Click on the Start button.
2.	 Select the File Explorer.
3.	 The File Explorer window 
will open.

Shortcut Keys Combination: Press Win + E key combination to open Window File Explorer.

 Opening a File and Folder
Follow the given steps to open a file and a folder. 
Steps: 
1.	 Click on the Start button.			 
2.	 Open the file explorer window.
3.	 Choose the folder or a file you want to open.        Or
1.	 Click the folder icon on the taskbar in Desktop view.

Figure 2.3: File Explorer Window

Figure 2.4: Opening File Explorer
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 Context Menu

A context menu (also called a contextual, shortcut, and pop-up or pop-
up menu) is opened when we right-click anywhere on the app. It provides 
options that can be accessed quickly. Let us know how to use the context 
menu.

 Using Context Menu

By using the context menu, a folder can be opened. 
Follow the given steps to open a folder using the 
context menu.

Steps:
1.	 Choose the folder you want to open.
2.	 Right-click on it.
3.	 From the context menu, select the open option. 
4.	 The desired folder will open.

 Renaming a File and Folder

Have you ever given a 
name to someone and 
wanted to change the 
name later? Similarly, 
sometimes you may want 
to change the name of 
an existing folder or file. 
In doing so, renaming is 
required. Renaming is to 
change the existing name 
of the file or folder. 

Figure 2.5: Context Menu

Figure 2.6: Renaming a File
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Follow the given steps to rename an existing file or folder: 

Steps:
1.	 Right-click on the folder or file 
that you want to rename.
2.	 Click on the Rename option from 
the context menu.
3.	 Type the new name for the folder or file.
4.	 Press enter.

 Deleting a File and Folder

There are some unused 
files and folders which 
you may want to delete. 
Deleted files or folders 
will be sent to the Recycle 
Bin.
Follow the given steps to 
delete an existing file or 
folder. 
Steps:
1.	 Right-click on the 

folder or file which 
you desire to delete.

2.	 Click on the delete 
option from the 
context menu.

Shortcut Keys Combination: Press the Shift + Del key combination.

Shortcut Keys: Press F2 
to rename a folder.

Figure 2.7: Deleting a File or Folder

Let Me Answer
What would you do if you save a Science 
project by the name of a Maths project?
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 Restoring a File and  Folder
Sometimes you might 
unintentionally delete a file. 
To bring back the file from the 
recycle bin is called restoring.  
Follow the given steps to restore 
any file or folder.

Steps:
1.	 Double-click on the Recycle 

bin icon on the desktop.
2.	 The contents of the Recycle 

bin get displayed in a new 
window.

3.	 Right-click on the file or the folder you want to restore. 
4.	 Click on the restore option from the context menu.
5.	 The file or folder will be restored to its original location.

Kids’ IQ
I am the pop-up menu you see when you right-click the mouse. Who am I?

Let’s Recall
•	 In Windows 10, multiple users can work on one computer system at the same 

time.
•	 A file is a collection of data or information.
•	 A folder serves as storage for files or other folders.
•	 A folder within a folder is called a Sub-folder.
•	 A context menu provides options that can be accessed quickly.
•	 Renaming is to change the existing name of the file or folder.

Figure 2.8: Restore



22Computer -4

Upskill Your Intelligence

A.	 Fill in the blanks.

	 1.	 The Search tool of Windows 10 is called .....................

	 2.	 We can open numerous desktops simultaneously by using the .................... 
button.

	 3.	 The type of file can be recognised by its .....................

	 4.	 A folder serves as .................... for files or other folders.

	 5.	 A context menu is also called a .................... menu.

B.	M atch the following.

	 1.	 Ctrl + Shift + N key	 Rename a folder

	 2.	 Win + E key	 Create a folder

	 3.	 F2	 Delete a folder

	 4.	 Shift + Del key	 Open File Explorer

C.	 Write ‘T’ for True statements and ‘F’ for False statements.

	 1.	 Search Tool is an application where you can get free and paid apps.	

	 2.	 A folder is a collection of data or information.	

	 3.	 Restoring is changing the existing name of the file or folder.	

	 4.	 After restoring, the file will move to its original location. 	

	 5.	 By using the context menu, a folder can be opened.	

D.	 Tick the correct answers.

	 1.	 Deleted files or folders will be sent to .....................
		    a. Search Tool	   b. Window Store
		    c. Recycle Bin	   d. Window Explorer
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	 2.	 A folder within a folder is called a .....................
		    a.	 In-folder		    b. Inside-folder
		    c. View-folder	   d. Sub-folder
	 3.	 It shows a series of commands to access quickly.
		    a. 	Title Bar		    b. Context Menu
		    c. Tab Menu		    d. View Menu
	 4.	 If you want to give a new name to a file or folder, you will .................... it.
		    a.	 Restore	   b. Delete	   c. Rename	   d. Move
	 5.	 Which button provides the ability to open multiple desktops at the same 

time.
		    a. Right click	   b. Task View	   c. Ctrl	   d. Shift

E.	 Answer the following questions.

	 1.	 State any three features of Windows 10.
		  ...........................................................................................................................
		  ...........................................................................................................................

	 2.	 What is a Folder?
		  ...........................................................................................................................
		  ...........................................................................................................................

	 3.	 What is the use of Context Menu?
		  ...........................................................................................................................
		  ...........................................................................................................................

	 4.	 Write the steps to rename a file.
		  ...........................................................................................................................
		  ...........................................................................................................................

	 5.	 Define a File.

		  ...........................................................................................................................
		  ...........................................................................................................................
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Critical Thinking

	 Rahul wants to create a folder. The steps he has written are not in sequence. 
Number the steps to help him create a folder.
•	 Windows will create the new folder at your current location.  
•	 Enter your desired folder name and press enter. 
•	 Select New then Folder from the contextual menu.		          
•	 Go to the location where you want to create the folder.
•	 Right-click on the blank space.

Team Work

	 Shade the files in red colour and the folders in yellow. Further, discuss the 
steps of deleting a file with your partner.
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More on Paint 3D
3

Warm-up

Identify and name the components of the 3D-Paint window.

At the end of this chapter, the students will be able to:
)) Transform a 2D drawing into a 3D model.
)) Add texture and stickers in Paint 3D.

Learning Outcomes

Teacher’s 
Note:

Apprise the students to recall what they learnt in class 3 about Paint 3D and assist them 
in identifying the components of the Paint-3D window.
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Windows 10 provides a free built-in creative app called Paint 3D. It 
is a fantastic programme that enables us to create either creative or 
professional projects. Both 2D and 3D tools are available.

Let us recapitulate what we learned in the previous class about the 
Paint 3D app. 

The Paint 3D window has the following options:

1.	M enu:  When you click on the expanded menu button, it opens a 
variety of list options such as New, Save, Save As and many more 
to perform multiple functions. 

2.	 Brushes:  Brushes tool has different brush types, which are used 
to draw lines by hand in various styles. It can be used to paint on 
both 2D and 3D surfaces. 

3.	 2D Shapes:  This option is used to draw 2D shapes. This tool has 
many readymade shapes such as Line, Rectangle, Stars, Arrows, 
Triangle and many more.

4.	 3D Shapes:  This option allows to draw 3D shapes, such as Cube, 
Cuboid, Cat, Woman, and many other 3D shapes.

“Hi friends! Let us learn 
how to add stickers and 
texture in Paint 3D.
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5.	 Stickers:  With this tool, we can 
select images from a ready-made 
image collection and apply them as 
stickers to our designs. The opacity 
of the chosen and applied sticker 
can also be changed.

6.	 Text Tool:  This tool allows to add 
2D text or 3D text options in the drawings. 

7.	 3D Library:  It is a collection of thousands of free 3D models 
divided into several categories.

Let Me Answer
Discuss the difference between 
2D and 3D shapes.

Figure 3.5: 3D Library Figure 3.6: Canvas

1. 2.

8.

3. 5. 7.

4. 6.

Figure 3.1: 2D Shapes Figure 3.2: 3D Shapes

Figure 3.3: Stickers Figure 3.4: Text Tool
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8.	 Canvas:  The canvas of the 3D 
Paint window is the area where 
we can draw different drawings.

 3D Library

Creative 3D objects can be created using Paint 3D. The app allows using 
a variety of pre-defined objects in the 3D Library. There are many 3D 
objects freely available in the 3D library built by professionals. 
Follow the given steps to insert 3D models from the Paint 3D library.
Steps:
1.	 Start Paint 3D from Apps.
2.	 Select 3D shapes from the ribbon and then Open the 3D library.

3.	 Type the object name into the search box and press enter. 

4.	 Click on the model of your choice to add it to the canvas.

 3D Doodles
A freehand sketch can be transformed quickly into a 3D object using 
Paint 3D. 3D doodles look very attractive.

Figure 3.7: Paint 3D App Window Ribbon

Do You Know?
By holding down the page up key, you can zoom 
in on the canvas.

Figure 3.9: Adding 3D Model to CanvasFigure 3.8: 3D Library Search Box

Let Me Answer
What does Doodle really mean?
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Follow the given steps to create a 3D doodle in Paint 3D.

Steps:

1.	 Launch Paint 3D.

2.	 Select 3D shapes from the ribbon.

3.	 Select any of the 3D 
doodles.

4.	 Just drag it on the 
screen and draw the 3D 
doodle on the canvas.

5.	 You may rotate, resize, 
and edit the colour of 
your 3D doodle after 
you’ve finished drawing it.

 3D Views
3D View enables you 
to edit from any angle, 
which means even more 
accurate and intuitive 
3D creation. You can 
move around your 3D 
designs.

Figure 3.10: Paint 3D

Figure 3.11: 3D Doodle

Figure 3.12: 3D View



30Computer -4

 Applying Stickers and Textures

Follow the given steps to apply stickers and textures.

Steps:
1.	 Select the 3D shapes tool.
2.	 In the 3D shapes panel, select the 

dog given under the category 3D 
models.

3.	 Select the stickers tool.
4.	 Add eyes and tongue sticker to the cat.		
5.	 Zoom in on the cat’s tail to add the fur texture.
6.	 Size and rotate the texture as desired.

 Creating 3D Text

The 3D text enables you to move it around the canvas and rotate in 
different directions. 
Follow the given steps to create some 3D Text.

Steps:
1.	 Select the text tool.
2.	 Click on the 3D text option.

Figure 3.13: 3D Model

Figure 3.14: 3D Text Tool Figure 3.15: Creating 3D Text
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3.	 Choose the desired font, font size, colour, style, and alignment to 
add 3D Text in the placeholder.

4.	 Click outside the placeholder to finish.

 History Tool

Each tool you use when 
making a new paint 3D 
model is recorded by the 
history tool. All of your 
actions can be reversed and 
undone; it’s like having an 
endless undo button.

By moving the History slider, you can replay the steps you used in creating 
a drawing.

Kids’ IQ
Samaira was watching keenly her teacher while she was drawing a 3D cartoon. 
Now, she forgets the steps which her teacher followed . Suggest to her the way she 
can recall the steps.

..............................................................................................................................................

Let’s Recall
•	 Windows 10 provides a free built-in creative app called Paint 3D.
•	 With the sticker tool, we can select images from a ready-made image collection 

and apply them as stickers to our designs.
•	 3D Library is a collection of thousands of free 3D models.
•	 A freehand sketch can be transformed quickly into a 3D object using Paint 3D.
•	 3D View enables you to edit from any angle.
•	 History slider replays the steps you used in creating a drawing.

Figure 3.16: History Tool
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Upskill Your Intelligence

A.	 Fill in the blanks.

	 1.	 .................... enables you to edit from any angle.

	 2.	 .................... allows replaying the steps used in creating a drawing.

	 3.	 We can choose 3D Doodle from .................... option.

	 4.	 .................... enables you to move the text around the canvas.

	 5.	 .................... is the area where we can draw different drawings.

B.	 Answer the following in one word.

	 1.	 The option allows drawing lines and stars.............................................

	 2.	  It is a collection of thousands of free 3D models.............................................

	 3.	 The tool allows adding tongue sticker.............................................

	 4.	 The number of options in paint 3D.............................................

	 5.	 The tool which can reverse the action............................................. 

C.	 Write ‘T’ for True statements and ‘F’ for False statements.

	 1.	 We can rotate the 3D doodle after drawing it.	

	 2.	 Each tool you use when making a new paint 3D model is recorded  
by the 3D text tool.	

	 3.	 Windows 10 provides a free built-in creative app called Paint 3D.	

	 4.	 We cannot apply texture to a 3D model.	

	 5.	 Zoom-in is not allowed in Paint 3D.	
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D.	 Tick the correct answers.
	 1.	 .................... tool is like an unlimited undo button.
		    a. 3D Text	   b. Brushes	   c. History	   d. Canvas
	 2.	 .................... allows to find the characters from the 3D library.
		    a.	 Find	   b. Search	   c. Explore	   d. Locate
	 3.	 We select 3D shapes from the .....................
		    a. 	Ribbon	   b. 3D Library	   c. Text	 	   d. Effects
	 4.	 .................... tool allows to add 2D or 3D text options.
		    a.	 Stickers	   b. Brushes	   c. Canvas	   d. Text
	 5.	 This view allows you to move around your 3D designs.
		    a. 2D	   b. 3D	   c. Sticker	   d. Animation

E.	 Answer the following questions.
	 1.	 What is the purpose of 3D tools?
		  ...........................................................................................................................
		  ...........................................................................................................................
	 2.	 Why do we use the Text tool?
		  ...........................................................................................................................
		  ...........................................................................................................................
	 3.	 Write the steps to apply stickers to the drawings.
		  ...........................................................................................................................
		  ...........................................................................................................................
	 4.	 How does the brush help in Paint 3D?
		  ...........................................................................................................................
		  ...........................................................................................................................
	 5.	 Write the use of 3D Views.
	 	 ...........................................................................................................................
		  ...........................................................................................................................
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Critical Thinking

A.	 From the given grid, find out the 8 components of Paint 3D.
S S H S U R B
X T W H S I D
L I B R A R Y
R C O T V Z T
B K M E N U F
K E P X A I Q
Z R J T C T B
A S X Y B E Z

B.	 Neha wants to create a park scene. For it, she needs to add some 3D 
objects on the canvas. Help her with the options through which she can 
add different objects and create a beautiful park scene.

Team Work

	 Draw a poster on 
‘Save Earth’ using 
3D Library. Use the 
stickers, 3D models 
and 3D text to 
beautify it.
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More On MS Word 2016
4 

Warm-up

Following sentences have spelling and grammatical errors, rewrite the 
sentences on the lines below.

1.	 children is plaing in the park.
	 .....................................................................................................................
2.	 There are betiful flowers.
	 ......................................................................................................................
3.	 alia are swinging.
	 ......................................................................................................................

At the end of this chapter, the students will be able to:
)) Move and copy the text.
)) Insert bullets, numberings and symbols.
)) Check the spelling and grammar.
)) Print the document.

Learning Outcomes

Teacher’s 
Note:

Apprise students that all the mistakes would have been underlined in MS Word 2016 if 
they had typed the above sentences with errors.
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As we know, one of the most widely used word processors produced by 
Microsoft is Microsoft Word. It facilitates the quick and simple creation, 
reading, editing, and sharing of files. It allows making changes in the 
content and appearance of the text. Text can be edited by inserting and 
deleting text, correcting grammatical errors and changing font settings. 

Let us learn about more editing features of MS Word 2016.

 Moving text

After you have done typing a section of text in Microsoft Word, you may 
need to move it somewhere else. 
Follow the given steps to move the text.

Steps:
1.	 Select the text you want to move. 
2.	 Click the Cut command on the 

Home tab. Alternatively, you can 
press Ctrl+X on your keyboard.

3.	 Place your cursor point where you 
want the text to appear.

4.	 Click the Paste command on the 
Home tab. Alternatively, you can 
press Ctrl+V on your keyboard.

“Hello friends! We have already 
learnt how to edit the text in MS 
Word 2016. In this chapter, we will 
learn more about its editing features.

Figure 4.1: Cutting Text

Figure 4.2: Pasting Text



37 Computer -4

 Copying Text

Word enables you to copy text which is already in your document and 
paste it to another location. 
Follow the given steps to copy the text.

Steps:
1.	 Select the text you want to copy.
2.	 Click the Copy command on the Home tab. 

Alternatively, you can press Ctrl+C on your 
keyboard.

3.	 Place your cursor point where you want the 
text to appear.

4.	 Select the Paste command on the Home tab.

 Bullets and Numbering
The use of bullets and numbering, often known as ordered or unordered 
lists, can make writing easier to read.

Bulleted List
Bulleted list is used when order does not matter. These lists show a 
graphic symbol with the list.
Follow the steps to use the bulleted list.
Steps:
1.	 Select the text you want to change into a list. 
2.	 Go to the Home tab, in the Paragraph group, 

and click the bullets command. 
3.	 A drop-down menu with different bullet 

styles will appear, select the bullet style.
4.	 The selected text will have a bulleted list.

Figure 4.3: Copying Text

Figure 4.4: Pasting Text

Figure 4.5: Bullet List

Figure 4.6: Paragraph

Let Me Answer
What is the easier way to copy a text?
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Numbered List
Numbered Lists follow some order and are used to display complete 
sentences or paragraphs in a series.
Follow the given steps to create a numbered list. 
Steps:
1.	 Select the text you want to change into a 

numbered list. 
2.	 Go to the Home tab, in the Paragraph group, 

and click the bullets command. 
3.	 A drop-down menu with different numbering 

styles will appear, select the numbering style.
4.	 The selected text will have a numbered list.

Inserting Symbols
You can easily insert a special character, fraction, or other symbols 
such as currency, check marks, and many more symbols in your Word 
documents. These symbols are needed in the documents where some 
formulas are to be typed. 
Follow the given steps to insert the symbols.
Steps:
1.	 Take the cursor in the file to the spot where you 

want to insert the symbol.
2.	 Go to Insert, and click on the symbol button located 

in the symbol group.
3.	 Choose the desired symbol or click on more symbols.
4.	 Use the Font selector above the symbol list to pick the font you desire.
5.	 Once you get the symbol of your choice, double-click it.
6.	 The symbol will be inserted, select the close button.

Figure 4.7: Numbered List

Figure 4.8:  
Inserting Symbols
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 Find and Replace

Sometimes while typing, there are words which we type incorrectly. To 
correct the spellings, we can use the Find and Replace option. The ‘find’ 
feature allows finding the word or particular text in the document and 
the ‘replace’ feature allows to replace it with the corrected or another 
word. 
Follow the given steps to find the text.

Steps:
1.	 Click on the Home tab.
2.	 Select the Find button in the Editing group.
3.	 A navigation panel will emerge on the left-hand side. Alternatively, 

you can press Ctrl + F key combination to open the navigation panel.
4.	 Mention the word you want to search in the ‘Search Document’ box. 
5.	 The mentioned word will be highlighted in the entire document.
Following are the steps to replace the text.
Steps:
1.	 Click on the Home tab.
2.	 Select the Replace button in the 

Editing group.
3.	 Find and Replace box will appear. 

Alternatively, you can press Ctrl 
+ H key combination to open the 
navigation panel.

4.	 In the ‘ Find What’ box, type the word that needs to be changed.
5.	 In the ‘ Replace With’ box, type the new word to replace the old word.
6.	 Press the ‘ Replace All’ button.
7.	 The mentioned word will be replaced with the new word.

Figure 4.10: Find and Replace Box

Figure 4.9: Find
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 Spelling and Grammar

Ms Word has an in-built tool which allows to correct spelling and 
grammatical errors. 
Follow the given steps to check the spelling and grammar.

Steps:
1.	 Select the text.
2.	 Click on the review tab.
3.	 In the proofing group, select 

Spelling and Grammar.
4.	 The spelling panel will 

appear on the right side. 
Suggestions will be shown 
to edit the incorrect word. 

5.	 Either select change or change all option.
6.	 Once done, a message will appear ‘The 

spelling and grammar check is complete.’

 Print Preview
A feature called print preview shows on the screen what a printed copy 
would look like. By checking the layout using a ‘print preview’ before 
printing, you can detect any possible problems and prevent the need for 
multiple prints, resulting in saving ink or toner and paper.
Follow the given steps to preview a document.

Steps:
1.	 Click on the File tab.
2.	 Select the Print option.
3.	 A preview of the document will appear.

Let Me Answer
Do you make errors while writing?

Figure 4.11: Spelling and Grammar

Do You Know?
We can open the spelling panel by 
pressing F7 key.

By pressing Ctrl + P key, the 
print preview will be shown.

Remember it!
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Printing the Document

Once the preview looks fine, follow the given steps to take the printout.

Each tool you use when making a new paint 3D model is recorded by 
the history tool. 

Steps:

1.	 Click on the File Tab.

2.	 Select the Print option.

3.	 Choose the printer from 
the Printer properties drop-
down list.

4.	 Mention the number of 
copies required for printing.

5.	 Press the print button.

6.	 Hard copy of the document will be there.

Kids’ IQ
Shreya has typed a letter. Now, she wants a hard copy of it. What should she do? 

..............................................................................................................................................

Let’s Recall
•	 Microsoft Word is one of the most widely used word processors produced by 

Microsoft.
•	 We can use the cut, copy and paste option for moving and copying the text.
•	 Editing can only be done by selecting the desired text.
•	 Numbered List follows some order while the bulleted list doesn’t. 
•	 Print preview shows on the screen what a printed copy would look like.

Figure 4.12: Print Preview
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Upskill Your Intelligence

A.	 Fill in the blanks.

	 1.	 Bulleted list is used when .................... does not matter.

	 2.	 Editing can only be done by .................... the desired text.

	 3.	 The spelling panel appears on the .................... side.

	 4.	 Replace button is present in the .................... group.

	 5.	 The .................... feature allows finding the word in the document.

B.	 Answer the following in one word.

	 1.	 The tab where the Cut option is present. 

	 2.	 Spelling Panel will appear using this key.

	 3.	 The tab where the print option is present. 

	 4.	 The list used for series.

	 5.	 This group has Spelling and grammar option.

C.	 Write ‘T’ for True statements and ‘F’ for False statements.

	 1.	 The Numbered list does not follow the proper order.	

	 2.	 Spell and grammar checks make the document error-free.	

	 3.	 Editing means making changes in the already typed text. 	

	 4.	 Division symbols can be added using bullets.	

	 5.	 Press Ctrl + P key combination to open the spelling panel.	
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D.	M atch the following.

	 Ctrl + C				   Paste	

	 Ctrl + P				    Find and Replace 

	 Ctrl + V				   Copy

	 Ctrl + H				   Navigation Panel	

	 Ctrl + F				    Print preview

E.	 Answer the following questions.

	 1.	 Write the steps to move a text.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 2.	 Explain the ‘Symbols’ feature in MS Word 2016?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 3.	 What is the use of bullets and numbering?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 4.	 What is the first step in copying any text?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 5.	 What is the purpose of ‘Find and replace’?

	 	 ...........................................................................................................................

		  ...........................................................................................................................
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Critical Thinking

A.	G aurav typed an essay on Summer Vacations. By mistake, he typed the last 
paragraph as the first paragraph. Suggest to him the options he should 
opt to make the necessary changes in the essay.

	 ....................................................................................................................................

	 ....................................................................................................................................

B.	 Unjumble the Tabs.
	 1.	 SITNRE	 - 	 ................................................................................................
	 2.	 MHEO	 - 	 ................................................................................................
	 3.	 WVIERE	 -	 ................................................................................................

Team Work

	M ake a list of your subjects according to Alphabetical order. Run spell 
check.

		  English		  maths			   science			   Hindi
		  computer		  Social studies		  Life skills.  (books)
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Formatting Features Of  
MS Word 2016

5 

Warm-up

Some words are given in the box below, segregate them into the appropriate 
columns: Good Habits and Bad Habits.

	 Get up Early Morning	 Addiction to social media	 Play Outside
	 Eating Junk food              	 Be Punctual 				   Exercise Daily
	 Use of Offensive Language	 Focusing on the negatives	 Be Happy

Good Habits Bad Habits

At the end of this chapter, the students will be able to:
)) Use formatting features.
)) Add pictures, shapes and symbols in a word document.

Learning Outcomes

Teacher’s 
Note:

Apprise the students that in the above exercise, we have changed the appearance of the 
text. This is called Formatting.
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Appealing documents always draw a reader’s attention. Microsoft Word 
has a number of tools that can be used to modify the document and 
give it a more attractive appearance by using various shapes, images, text 
styles, etc.

 Tables in MS Word

A document that includes several types of information, such as content, 
numbers, images and much more information, requires the information 
to be displayed in rows and columns. For example, the School Report 
card and timetable. All the pieces of information are placed in rows and 
columns.

“Hello friends! When we make our school 
projects, we always beautify them by adding 
stones, glitters and many more things. Let’s 
learn about different ways to make our typed 
document look attractive.

Figure 5.2: Time TableFigure 5.1: Report Card

Let Me Answer
How do you make your projects attractive?
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We find it simpler to read and better able to comprehend information 
when it is presented in rows and columns. MS word allows us to represent 
the information in the row-column format in a Table.

Adding Tables

A table is made up of rows and columns. The intersection of a row and 
column is called a cell.

Follow the given steps to insert a table in a 
document.

Steps:

1.	 Click on the Insert tab and select the table button.

2.	 A grid will appear, move the cursor over the 
grid until you highlight the number of columns 
and rows you want.

3.	 Click once, and the table will be inserted in the document. 

Once the table is inserted, simply click in the cell and start typing the 
numbers, text, etc.

 WordArt

WordArt is a text modifying feature in Microsoft Word with effects 
such as shadows, outlines, colours, gradients, and 3D effects that can be 
added to a word or phrase. It can be changed even after it is inserted in 
a document. 

Figure 5.3: Insert Tab

Figure 5.4: Insert Table

Let Me Answer
Can you name some other things 
which are referred to as a cell?
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Follow the given steps to add WordArt in a document.
Steps:
1.	 Click Insert > 

WordArt, and 
pick the WordArt 
style you want.

2.	 Click on the 
desired style.

3.	 The placeholder text box in the document with the sample text will 
appear “Your text here”. 

4.	 Enter your own text to replace the placeholder text.

Editing and Formatting Word Art Text

Follow the given steps to edit Word Art text.

Steps:

1.	 Select the Word Art you want to edit.

2.	 From the WordArt style drop-down list, select a WordArt style. 

3.	 Select the Text effects from the different effects available in the Text 
Effects drop-down list.

4.	 Click outside the dotted box.

5.	 The edited WordArt will appear.

Figure 5.5: Inserting WordArt Figure 5.6: WordArt

Figure 5.7: Format WordArt Figure 5.8: Text Effect



49 Computer -4

 Inserting Picture

Adding pictures in the written 
document makes it look creative 
and interesting. Let us learn how 
to insert pictures in the word 
document.

Follow the given steps to insert images in a document.

Steps:

1.	 Click on the Insert 
tab.

2.	 Under the illustrations 
group, select the 
pictures option. 

3.	 The Insert picture box 
will appear.

4.	 Explore the library 
and choose the image you want.

5.	 Select the picture and click on the Insert button.
6.	 The chosen picture will be inserted in the document.

 Using Shapes

Shapes of all kinds, including boxes, rectangles, callouts, circles, arrows, 
lines, triangles, curves, equation shapes, and many more, are available in 
MS Word. Once the shape has been added, you can change its attributes, 
such as colour, style, format, size, and outline. Further, you can add 3D 
effects such as beveling, perspective, reflection or glow.

Figure 5.9: Insert Tab

Figure 5.10: Insert Pictures
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Follow the given steps to insert Shapes in a Word document.
Steps:

1.	 Click on the Insert tab.

2.	 From the illustration group, select the 
Shapes option.

3.	 Choose the shape from the long 
list of shapes available.

4.	 Once the shape is selected, a (+) 
shaped cursor will appear on 
the page.

5.	 Drag the mouse to draw out the 
shape.

6.	 Release the mouse to get the 
chosen shape.

Follow the given steps to format the shape.
Steps:

1.	 Select the already inserted shape.

2.	 Under drawing tools, select the format tab.

3.	 Select the desired options to modify the shapes.

 Format Painter

The format painter is a tool that enables us to apply a formatting effect 

Figure 5.12: Shapes Figure 5.13: Inserting Shapes

Figure 5.14: Format Tab

The default colour of the 
shape is blue.

Remember it!

Figure 5.11: Shapes Button
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from a previous text to other words or sentences. It facilitates our job 
and saves a great deal of time, just like the copy and paste function.

Follow the given steps to apply formatting effect to any text.

Steps:

1.	 Select the text of which you want to copy the format.

2.	 Click on the Home tab.

3.	 From the clipboard group, select the format painter option.

4.	 Cursor will change to a brush symbol.

5.	 Position the cursor at the start of the text on which you want to apply 
the format.

6.	 Drag the brush over the text.

7.	 The selected text will be formatted.

Kids’ IQ
You are the head girl/ boy of the school. You need to collect information about 
the students of all classes. ( Name, Parent’s name, age, address, number, and much 
more). You are really confused about what needs to be done in order to arrange the 
data in some order. How would you manage?

Let’s Recall
•	 A table is made up of rows and columns.
•	 The intersection of a row and column is called a cell.
•	 WordArt is a text modifying feature in Microsoft Word.
•	 We can insert different types of shapes in the document.
•	 Format Painter copies the format of one text to other text.
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Upskill Your Intelligence

A.	 Fill in the blanks.

	 1.	 .................... and .................... are the two types of style.

	 2.	 The text you enter into a new document by default is based on the 
.................... style.

	 3.	 Lines, Basic shapes, Block Arrows are the options of .................... button.

	 4.	 The .................... feature allows to create special text effects.

	 5.	  .................... is a placeholder where text can be typed in.

B.	 Answer the following in one word.

	 1.	 The default extension for MS-Word file.

	 2.	 The type of software is MS-Word.

	 3.	 The shortcut key to create a new document in MS-Word.

	 4.	 The use of combination keys Ctrl + S in Microsoft-Word.

	 5.	 The shortcut key to undo the last actions in the MS-Word.

C.	 Write ‘T’ for True statements and ‘F’ for False statements.

	 1.	 Text cannot be formatted within the text box.	

	 2.	 You cannot insert text in Shapes.	

	 3.	 The Ctrl+F1 key combination is used to hide/show the Ribbon. 	

	 4.	 Shape Fill tool is used for colouring a drawing object.	

	 5.	 A theme is a set of formatting choices that can be applied to an 
 entire document.	
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D.	M atch the following.

	 Column				   Vertical Data

	 Row					    To combine two or more cells

	 Merging				   Horizontal data

	 Splitting				   To change the size

	 Resize				    Breaking of Multiple cells

E.	 Answer the following questions.

	 1.	 What exactly do you mean by “style”? List the various styles.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 2.	 Describe the Textbox. How can a text box be resized?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 3.	 Describe ClipArt. What distinguishes it from WordArt?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 4.	 Why is the WordArt feature there?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 5.	 Describe Microsoft Word’s Shapes feature.

	 	 ...........................................................................................................................

		  ...........................................................................................................................
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Critical Thinking

	 Copy and paste the words and pictures into the matching boxes.
	 Orange
	 Green
	 Yellow
	 Purple
	 Brown
	 Black
	 Pink
	 Grey
	 Blue

Baseball

Basketball

Kitty

Fish

Penguin

Green
Yellow
Black
Purple
Pink
Blue
Brown
Grey
Orange
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Team Work

	 Award Certificate Lesson Activity for Teaching Microsoft Word Skills

	 Description
	 A fun assignment where students design their own award certificate for 

themselves or anyone else, they desire by adhering to specific instructions. 
Students will demonstrate their command of the following Microsoft Word 
abilities after completion.

	 •	 Font And Paragraph Formatting
	 •	 Page Orientation
	 •	 Applying Pictures as a Page Color
	 •	 Inserting Pictures And Text Boxes
	 •	 Picture Background Removal
	 •	 Inserting Signature Lines
	 •	 Text Wrap
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More about Scratch 3.0
6 

Warm-up

Label the scratch Window Components.

At the end of this chapter, the students will be able to:
)) Know about different blocks in Scratch.
)) Change different backdrops in Scratch projects.

Learning Outcomes

Teacher’s 
Note:

Assist the students in labelling the components of the Scratch Window. Motivate them to 
recall Scratch, which is a programming language that lets you create interactive stories, 
animations, games, music and art. 
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Scratch doesn’t require any code for giving instructions to 
the computer. It uses blocks to perform a specific task. For 
using these blocks, all you have to do is to understand what 
these blocks can do for us.

 Blocks Palette

A vertical strip located just beneath the Code tab is described 
as a block palette. The Block palette contains a total of nine 
blocks. There are numerous sub-blocks available when we 
click on a specific block.

 Motion Block

One of the ten categories of scratch 
blocks is motion blocks. They are 
medium-blue in colour and are used to 
direct a sprite’s movement on stage.

Follow the given steps to move a sprite using Motion Block.

Steps:

1.	 Click on the Motion Block button.

“Hello friends! In the previous 
class, we learnt about creating, 
opening and saving Scratch. Now, 
let’s learn about the different blocks 
in Scratch.

Figure 6.1: 
Blocks Palette

Let Me Answer
Can you relate more with the characters 
which shows movement?
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Figure 6.2: 
Blocks Palette

Figure 6.3: Blocks Palette

2.	 The code palette will show a list of blocks that belong 
to Motion Block.

3.	 Click on the move 10 steps block, and drag this block 
to place it in the Script area.

4.	 Now, click on the turn 15 degrees block and place it 
just after the move 10 steps block in the script area. 

5.	 Run the code by clicking on the blocks in the script 
area.

 Looks Block

Purple-coloured blocks are Looks blocks. They control a Sprite’s 
appearance including its costume and backdrop.

ˡˡ Use the Say hello for 2 seconds block 
to display the message with Sprite 
on the screen.

ˡˡ Use Think hmm for 2 seconds to add a ‘thinking cloud’ to the Sprite. 
It will continue to appear until another speech or thinking block is 
activated, or the stop button is pressed.

Let Me Answer
Have you ever changed the costume of 
any ideal you worship or toy you have?
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Follow the given steps to change the costume of a Sprite.

Steps:

1.	 Click on Choose a Sprite button on the bottom right 
side of the Scratch window.

2.	 Select Dani Sprite to click on the Costume tab.

3.	 From the list of costumes, select Dani-b costume. 

4.	 The sprite’s costume will be changed.

 Pen Block

The Pen blocks are green in colour. These blocks draw 
a trail as the Sprite moves on the stage. Pen colour can 
be changed. This block is present as an extension to the 
Scratch 3.0

Follow the given steps to add pens to the block category.

Steps:

1.	 Click on the Add Extension button at the bottom 
left corner of the Code tab. 

2.	 Click on the 
Pen option 
and it will be 
added to the 
Code tab.

Figure 6.4: 
Blocks Palette

Figure 6.5: 
Blocks Palette

Figure 6.6: Drawing Shapes with Pen Block
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 Sound Block

Sound Blocks are in pink colour. They 
make animation lively by adding different 
sounds to a project. You can even record 
your voice and save it.

Follow the given steps to add sound in a project.

Steps:

1.	 Click the sound block. 

2.	 Select the play sound meow until done and drag 
this block and place it under the Script Palette.

3.	 Run the code by clicking on the blocks in the 
Script area.

4.	 To stop all sounds being played on all sprites, 
use the stop all sounds block.

 Events Block

Events Block is yellow in colour and controls the 
events and the starting of the scripts. You can 
click on the Sprite with a mouse or a keyboard to 
control it. The interaction with the Sprite is called 
Events.

ˡˡ Used when green flag block is clicked to execute 
the attached blocks.

ˡˡ The space key pressed block executes the 
attached blocks when a keyboard key is pressed.

Figure 6.7: Sound Block

Blocks should be placed in order
Remember it!

Figure 6.8: Event Block
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ˡˡ This sprite 
clicked block 
executes the 
attached 
blocks when 
the left 
mouse is 
clicked at the 
Sprite.

 Control Block

Control Block is yellow in colour and controls the 
flow of the scripts. They provide functions for looping 
various blocks and scripts. The most commonly used 
control blocks are: 

The repeat block: this block repeats a set of blocks for 
a given number of times. 

The wait 1 second : this block pauses the running of 
the script till the specified time.

The forever block : this block keeps on repeating a set 
of blocks till the stop button is clicked.

 Changing the Backdrop

The stage background is the term used to describe the backdrop. To 
make our projects more exciting and engaging, we can modify the stage’s 
backdrop. By default, the backdrop of the stage is white. We can either 
make our backdrop or choose the backdrop available in the library. 
Below the stage area, the backdrop option is present.

Figure 6.10: Control Block

Figure 6.9: Event Blocks Output
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There are four different options for changing the 
backdrop of the stage. They are:

ˡˡ Choose a backdrop
ˡˡ Paint
ˡˡ Surprise
ˡˡ Upload Backdrop

Follow the given steps to choose a backdrop for 
the sprite.

Steps:

1.	 Click on the Choose a Backdrop button. 

2.	 Choose a Backdrop window appears.

3.	 From the preview list, select the Blue Sky backdrop. The Blue Sky 
backdrop at the background of the Sprite will be added.

Kids’ IQ
Your friend is creating a project in Scratch. She wants to create a new sprite in her 
project. Suggest to her the steps to do the same.

..............................................................................................................................................

Let’s Recall
•	 A vertical strip located just beneath the Code tab is described as a block palette. 
•	 Numerous sub-blocks are available when we click on a specific block.
•	 Purple-coloured blocks are Looks blocks.
•	 Sound Blocks can record your voice and save it.
•	 Motion Blocks are used to direct a sprite’s movement on stage.
•	 Backdrop is referred to as the background of the stage.

Figure 6.12:  
Changing the Backdrop
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Upskill Your Intelligence

A.	 Fill in the blanks.
	 1.	 Scratch uses .................... to perform a specific task.
	 2.	 Block Palette is a vertical strip located just beneath the .................... tab.
	 3.	 Below the .................... area, the backdrop option is present.
	 4.	 Purple-coloured blocks are .................... blocks.
	 5.	  By default, the backdrop of the stage is .....................

B.	 Write the functions of these blocks.

	 1.	 Turn 15 degrees - 	 .....................................

	 2.	 Think hmm for 2 seconds -	 .....................................

	 3.	 Repeat 10 -	 .....................................

C.	 Write ‘T’ for True statements and ‘F’ for False statements.

	 1.	 Scratch requires code for giving instructions to the computer. 	

	 2.	  Control Block controls the flow of the scripts.	

	 3.	 The interaction with the Sprite is called Events. 	

	 4.	 Pen colour cannot be changed.	

	 5.	 Motion Block is used to direct a sprite’s movement on stage.	

D.	 Tick the correct option.
	 1.	 Which of the following blocks are used to control the appearance of 

Sprite?

		    a. Control	   b. Sound	   c.	Looks	   d. Event

	 2.	 The term is referred to as the background of the stage.

		    a.	 Canvas				      b. Backdrop
		    c. Workarea				      d. Foreground
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	 3.	 Colour of Look blocks is .....................

		    a.	 Yellow	   b. Pink	   c. Green	   d. Purple

	 4.	 The block controls the events and the starting of the scripts.

		    a.	 Looks 	   b. Motion	   c. Event	   d. Pen

	 5.	 Pink colour is of .................... block.

		    a.	 Sound 	   b. Motion	   c. Pen	   d. Control

E.	 Answer the following questions.

	 1.	 Write the use of Motion blocks.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 2.	 What is the use of Pen block?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 3.	 Name the different blocks available in Scratch.

		  ...........................................................................................................................

		  ...........................................................................................................................

	 4.	 How can we add music in Scratch?

		  ...........................................................................................................................

		  ...........................................................................................................................

	 5.	 Write the steps to change the background.

	 	 ...........................................................................................................................

		  ...........................................................................................................................
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Critical Thinking

A.	 John is creating a story with audio in Scratch. He notices that the audio 
is playing even after the story is over. Suggest to him the way which he 
should use to stop the audio.

	 ....................................................................................................................................

	 ....................................................................................................................................

B.	 Search the names of the blocks in the grid given below.
A Z R W C I W E C
H L F M O Y J V X
O S O U N D P E R
H C Q E T G N N K
V M P N R U O T Q
E X S L O O K S J
D T L I L S P K T
M O T I O N V U B

Team Work

	 Work in Pairs. Create this project in Scratch and enjoy it. Further, continue 
the conversation.
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MS PowerPoint 20167 

Warm-up

Rahul and Saumya are best friends. Rahul adopted a cat a few days back, and 
Saumya is curious about her. So, she asks several questions, and Rahul shows 
the pictures for her answer. 
Match the questions asked by Saumya with the pictures shown by Rahul.

Column A Column B

Q1. What is the colour of your cat?

Q2. What do you feed your cat?

Q3. What do its eyes look like?

Q4. Which is its favourite posture?

At the end of this chapter, students will be able to:
)) Start PowerPoint 2016
)) Differentiate between slides and presentation.
)) Know the components of the PowerPoint window
)) Create, save and close the presentation.

Learning Outcomes

Teacher’s 
Note:

Inform students that the human mind is capable of understanding visual clues better than 
words and introduce them to that one such program which allows us to present information 
effectively is, MS PowerPoint 2016.
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“Hello friends! It’s always better to 
beautify the text file with pictures and 
animations. Let’s learn how to do it.

PowerPoint is a popular application 
program that allows you to create and 
show slides to support a presentation. 
These presentations can include 
animation, narration, images, videos, 
backdrop, and more.

 Advantages of presenting data in PowerPoint

Using a PowerPoint presentation has the following advantages:
1.	 Organise and structure your presentation.
2.	 Animate your slide to enhance the visual impact.
3.	 Make ideas more attractive so that others can easily understand. 
4.	 Provide an illustrative backdrop for the content of your presentation.

 Starting MS PowerPoint 2016

Follow the given steps to start MS PowerPoint 2016

Steps:
1.	 Click on the Start button.
2.	 Scroll down to Alphabet P and click on PowerPoint 2016.
3.	 PowerPoint Screen appears.

Do You Know?
Start Screen is also called Backstage View. 

To create a shortcut for Microsoft 
PowerPoint 2016, drag its icon from 
the start menu to the desktop.

Remember it!
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Presentation and Slides are two very important components of PowerPoint 
2016. A slide in PowerPoint is where information can be placed in the 
form of text, pictures, sounds, animation and much more. A collection 
of many slides is called a Presentation. The introductory slide of the 
Presentation is called the Slide Master. When all the combined slides of 
a presentation are shown to the audience, it is called a Slide Show.

 Components of MS PowerPoint 2016 Window

Figure 7.1: Starting PowerPoint Figure 7.2: PowerPoint Home Window

Figure 7.3: Components of PowerPoint Window

Navigation Pane

Notes Pane Zoom Control

PlaceholderRibbonQuick Access Toolbar
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Quick Acces Toolbar:

This toolbar appears on the left side of the PowerPoint 2016 title bar. It 
contains shortcuts for commonly used commands, such as Undo, Redo, 
Save, slideshow and many more.

The Ribbon:

The rectangular bar on the top of the PowerPoint window just below the 
Title bar is The Ribbon. A ribbon is made up of Tabs and Groups. It has 
multiple tabs, each with several groups of commands.

Slide Navigation Pane:

You can easily organise your slides using the Slide Navigation pane on 
the left side of the screen.  From here, you can duplicate, rearrange, and 
delete slides in your presentation.

Vertical & Horizontal Scroll Bars:

In a presentation, we can view a particular slide section by clicking, 
holding, and dragging the vertical or horizontal scroll bar.

Slide Pane:

We can view and edit the chosen slide right here.

Zoom Control:

We can change the percentage view of a slide by adjusting the zoom. The 
number to the right of the slider reflects the zoom percentage. 

Let Me Answer
Discuss the difference between a real 
ribbon and a ribbon in Ms PowerPoint.

Figure 7.4: PowerPoint Ribbon
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Notes Pane:

Notes can be written here for the current slide. The speaker can only 
view them and doesn’t appear when the presentation is running. 

Slides View Option:

There are different slide viewing options:

Normal View:

It is the default view in which the selected slide is displayed, along with 
the slide navigation window.

Slide Sorter:

It displays smaller versions of all the slides in the presentation.

Reading View:

In this view, we can review slides more easily because all the modifying 
tools are hidden in this.

Slide Show:

Slides from a presentation will be played through this.

Backstage View:

Backstage View 
creates new 
presentations. You 
can also open, 
save, print, create 
PDF and share 
presentations from 
the Backstage view.

Figure 7.5: Backstage View

Let Me Answer
How do you like to view the slides?
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Do You Know?
Ctrl + N is the shortcut key combination 
for making a new blank presentation.

 Creating a New Presentation

Follow the given steps to create a  new presentation.

Steps:

1.	 Click on the File Tab.			 
	

2.	 Select Blank presentation in the Backstage view. 

3.	 A new blank presentation will appear with a blank side.

 Slide Layout

The arrangement of the slide’s contents is referred 
to as the slide layout. Depending on the kind of 
information we want to include, we can choose 
a layout for our slide. Every time we make a new 
slide, we must select a slide arrangement that 
works with the information. A slide’s default 
layout is “Title Slide Layout.”

Figure 7.6: New Slide Option

Figure 7.7: Layout Button



72Computer -4

Follow the given steps to change the layout.

Steps:
1.	 Click on the home tab.
2.	 In the slides group, click on the Layout button.
3.	 Select an appropriate layout for your slide.

 Saving a Presentation

Always save the presentation before closing it. It allows to re-access the 
presentation in the future. 
Follow the given steps to save a presentation.

Steps:
1.	 Click on the File tab.
2.	 Select the save or save as command and click on the Browse option.
3.	 The Save as dialogue box appears. Select the location of a file. 
4.	 Give the name to the presentation.
5.	 Click on the Save button.
6.	 The presentation will be saved with an extension .pptx.

Figure 7.8: Slide Layout

Figure 7.9: Backstage Window Figure 7.10: Save As Dialog Box
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 Closing a Presentation

Follow the given steps to 
close the presentation.

Steps:
1.	 Click on the File tab.
2.	 Select the close option.
3.	 The currently open 

presentation will be 
closed.

 Exiting a Presentation

To exit PowerPoint, click on the Close button ( x) on the Title bar.

Kids’ IQ
What is the difference between closing a presentation and exiting the PowerPoint?

..............................................................................................................................................

Let’s Recall
•	 PowerPoint is a popular application program that allows you to create and 

show slides to support a presentation.
•	 PowerPoint provides an illustrative backdrop for the content of your presentation.
•	 A collection of many slides is called a Presentation.
•	 You can easily organise your slides using the Slide Navigation pane.
•	 Slide Sorter displays smaller versions of all the slides in the presentation.
•	 Different layouts can be chosen based on the information.
•	 Microsoft Office saves the presentation with an extension .pptx.

Figure 7.11: Closing a Presentation
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Upskill Your Intelligence

A.	 Fill in the blanks.
	 1.	 A collection of many .................... is called a presentation.
	 2.	 .................... view is the default view in PowerPoint.
	 3.	 Microsoft office saves the presentation with an extension .....................
	 4.	 .................... pane is used to write notes.

B.	 Answer in one word.
	 1.	 The arrangement of the slide’s contents.......................................
	 2.	 The percentage view of a slide can be changed by adjusting the zoom.
		  ......................................

	 3.	 We can view and edit the chosen slide right here.......................................
	 4.	 This toolbar appears on the left side of the PowerPoint 2016 title bar.
		  ......................................

C.	 Write ‘T’ for True statements and ‘F’ for False statements.
	 1.	 The introductory slide of the Presentation is called the  

Introduction.	
	 2.	 A ribbon is made up of Tabs and Groups.	
	 3.	 A slide’s default layout is “Title Slide Layout.”	
	 4.	 MS PowerPoint doesn’t allow to add animations.	
D.	 Tick the correct option.

	 1.	 Quick Access toolbar doesn’t contain a shortcut for this command.

		    a. Redo	   b. Save	   c.	Open	   d. Undo

	 2.	 .................... displays smaller versions of all the slides in the presentation.

		    a. Slide Sorter			     b. Normal View
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		    c. Slide Show				     d. Reading View

	 3.	 In which tab, Save As option is present?

		    a.	 Format	   b. Insert	   c. File	   d. View

E.	 Answer the following questions.

	 1.	 What is the use of MS PowerPoint?

		  ...........................................................................................................................

	 2.	 Write the steps to change the layout of the slide.

		  ...........................................................................................................................

	 3.	 Explain different Slide view options.
		  ...........................................................................................................................
	 4.	 Write the difference between slides and presentation.
		  ...........................................................................................................................

Critical Thinking

	H arman has made a beautiful presentation on “Save Earth”, but she forgets 
the steps to save it. Suggest to her the option she can use to complete the 
task.

	 ....................................................................................................................................
	 ................................................................................................................................

Team Work

	 Find out information on ‘Global Warming’ and prepare 10 Slides in 
PowerPoint. Include causes and ways to prevent it. 
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More On PowerPoint 2016
8 

Warm-up

Rohan and Sohan have learnt about MS PowerPoint 2016, but Sohan doesn’t 
remember the components of MS-PowerPoint Window. Help Sohan to recall.

At the end of this chapter, the students will be able to:
)) Insert a new slide and delete a slide.
)) Format text in a slide.
)) Insert pictures from a file or internet.
)) Apply colour to the background of a slide.

Learning Outcomes

Teacher’s 
Note:

Assist students with labelling the components of MS PowerPoint 2016. Also, ask them to 
recall why PowerPoint is a useful presentation tool.
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You are already familiar with how to make slides and add text. You will 
discover more about PowerPoint’s advanced features in this chapter.

 Opening a Presentation

Follow the given steps to open the saved presentation.

Steps:
1.	 Click on the File tab.
2.	 Select the open 

command from the left 
pane.

3.	 Locate and select the 
presentation you want to 
open.

4.	 Click on the Open button.

 Inserting a New Slide

Any number of slides can be inserted in our presentation.

Follow the given steps to insert a new slide.

Steps:
1.	 Click on the Home tab.

“Hi friends! In the previous chapter, 
we learnt about the uses of  MS 
PowerPoint. Now let’s learn using the 
slides in PowerPoint. 

Figure 8.1: Opening a Presentation

Do You Know?
We can create a duplicate slide by 
pressing Ctrl + D key combination.
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2.	 From the slides group, click on the New slide.
3.	 Select the type of slide you want.
4.	 A new slide is inserted.

Alternatively, you can click on the Insert tab > New slide.

 Deleting a Slide

Some slides may look irrelevant, so we can delete them in the Normal 
view or in the Slide Sorter view.

Follow the given steps to delete a Slide.

Steps:
1.	 Choose the slide you 

want to remove.
2.	 Right-click on it in the 

Outline Pane.
3.	 From the shortcut 

menu, choose the 
Delete Slide option. 

4.	 The slide will be deleted.

 Formatting Text in a Slide

Making changes in the text’s appearance to make it more exciting and 
attention-grabbing is referred to as formatting.

Figure 8.2: Inserting New Slide

Figure 8.3: Deleting a Slide

Let Me Answer
How do you realise that 
something is irrelevant and 
needs to be deleted?



79 Computer -4

We can use the following features to format slides in a PowerPoint 
presentation:

 Font Style and Font Size

Follow the given steps to change the size of the selected text.

Steps:
1.	 Select the text you want to 

change.

2.	 On the Home tab, in the Font 
group, click on the drop-down 
arrow next to the Font Size box.

3.	 Click on the desired font size, and the text size will be changed.

Follow the given steps to change the size of the selected text.

Steps:

1.	 Select the text you want to change.

2.	 On the Home tab, in the Font group, 
click on the drop-down arrow next to 
the Font Style box.

3.	 Move the cursor over the available font 
styles. 

4.	 Select the desired font style. 

5.	 The font style will be applied to the 
selected text.

 Changing Font Colour

Follow the given steps to change the font colour.

Figure 8.4: Font Size

Figure 8.5: Font Style

Let Me Answer
What is the perfect font size according to you?
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Steps:
1.	 Select the text.
2.	 On the Home Tab, click on the 

drop-down arrow next to the Font 
colour box.

3.	 Choose the desired color.
4.	 The font color will be applied to the selected text.

 Adding Pictures

Pictures have more visual impact than the text. PowerPoint lets you 
insert images or pictures in your presentation. 

Follow the given steps to insert an image from a file.

Steps:
1.	 Take the cursor where you 

want to insert a picture on 
the slide.

2.	 Click on the Insert tab; click 
on the Pictures button in 
the Images group. 

3.	 A dialogue box will appear.
4.	 Browse to the location 

where you have saved your picture file.
5.	 Select the desired picture and click the insert button.
6.	 The picture will appear on the slide. 

Follow the given steps to insert an image from a file.

Steps:
1.	 Take the cursor where you want to insert a picture from the internet.

Figure 8.6: Font Color

Figure 8.7: Inserting Picture
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2.	 Click on the Insert tab. 
Click on the drop-down 
arrow in the images group 
below the picture button.

3.	 Click on the Online Pictures 
button. 

4.	 A dialogue box will appear. 
Type the name of the picture 
you want to search in ‘ Search Item name’ and then press enter.

5.	 Related pictures will appear. 
6.	 Select the desired picture and click on the Insert button. 

Resizing Pictures

The size of the images can be increased or decreased. 

Follow the given steps to resize the image.

Steps:
1.	 Click on the image.
2.	 Sizing handles will appear around the edges of the picture.
3.	 Move the mouse pointer over a sizing handle.
4.	 The shape of the cursor will change to a double-headed arrow.
5.	 While holding the mouse button, drag the mouse inwards to decrease 

or outwards to increase the size of the picture.
6.	 Release the mouse button once the picture is resized as desired.

Moving Pictures

The position of the pictures can be changed. 

Follow the given steps to change the position of the picture.

Figure 8.8: Inserting Online Picture
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Steps:
1.	 Click on the image.
2.	 Sizing handles will appear around 

the edges of the picture.
3.	 Move the mouse pointer over a 

sizing handle.
4.	 The shape of the cursor will change to a four-headed arrow.
5.	 While holding the mouse button, drag the mouse in the required 

direction. 
6.	 Release the mouse once the picture is positioned.

 Adding Colour to the Background of a Slide

There are many ways of setting background color in a slide. Let’s learn 
about the following ways:

Using the Themes Option

Follow the given steps to add a background style using the theme options.

Steps:
1.	 Click the desired slide.
2.	 Click on the Design tab. In the 

Themes group, choose the themes 
you want to apply.

Using the Solid Fill Option

Follow the given steps to add a background style using the Solid Fill 
options.

Steps:
1.	 Select the Format Background button from the design tab.

Figure 8.9: Moving a Picture

Figure 8.10: Applying Themes
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2.	 In the format Background Pane, 
Choose solid or gradient fill.

3.	 Choose the desired color option. 
4.	 The color of the slide changes.

Select Apply to all on the format 
background pane if you want all slides 
to have the same background color.

Using the Picture or Texture fill Option

Follow the given steps to add a background style using the Solid Fill 
options.

Steps:
1.	 Select the Format Background 

button from the design tab.
2.	 In format Background Pane, 

Choose Picture or Texture fill.
3.	 Choose a picture in the Insert 

picture.
4.	 Browse and select the picture you want to apply on the slide and 

press the Insert button.
5.	 The chosen picture will be applied as a background to the slide.

 Slide Show

Slide show is a series of slides which displays all the slides on the screen 
one by one. The slide show should be previewed so that any necessary 
modifications may be made before it is finalised.

Follow the given steps to view the Slide show.

Figure 8.11: Applying Themes

Figure 8.12: Applying Background

Use the F5 key to view 
the slide show.

Remember it!
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Steps:

1.	 Click on the Slide Show tab.

2.	 Select one of the following options in the Start Slide Show group:

	 a.	 From Beginning 

		  Starting the presentation with 
the first slide.

	 b.	 From Current Slide

		  Starting the presentation with 
the current slide.

	 c.	 Custom Slideshow

		  Starting the presentation with only the selected slides.

Kids’ IQ
‘You can add only 50 slides in one presentation.’, said Mayank. Do you think 
Mayank is right?

............................................................................................................................................

Let’s Recall
•	 PowerPoint 2016 helps you create beautiful presentations. 
•	 Slide show is a series of slides which displays all the slides on the screen one 

by one.
•	 A presentation is made up of a series of slides. 
•	 The size of the images can be increased or decreased. 
•	 Pictures have more visual impact than text.

Figure 8.13: Viewing Slide Show
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Upskill Your Intelligence

A.	 Fill in the blanks.

	 1.	 .................... is a series of slides which displays all the slides on the screen 
one by one.

	 2.	 We can delete the slides in the .................... view or in the .................... 
view.

	 3.	 A .................... is made up of a series of slides. 

	 4.	 Select Apply to all on the .................... if you want all slides to have the 
same background color.

	 5.	 Release the .................... once the picture is positioned.

B.	 Match the following.

	 1.	 Slide Show		  Slide Show	

	 2.	 Font Color		  Font Color

	 3.	 Font Style		  Font Style

	 4.	 Font Size		  Font Size

	 5.	 New Slide		  New Slide

C.	 Tick the correct option.

	 1.	 Which tab is used to add a font color in the text?

		    a. Design	   b. View	   c.	Home	   d. Insert

	 2.	 Which tab contains all the options to change the background of a slide?

		    a. Format				      b. Design

		    c. Slide Show				     d. Animations
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	 3.	 While resizing the picture, The shape of the cursor will change to a 
......................

		    a.	 Single-headed arrow	   b. Flower
		    c. Double-headed arrow	   d. Pointer
	 4.	 Making changes in the text’s appearance is referred to as
		    a. Formatting 			     b. Viewing
		    c. Resizing				      d. Moving

D.	 Answer the following questions.
	 1.	 Write the steps to insert a new slide in a presentation.
		  ...........................................................................................................................
	 2.	 What do you mean by slide show?
		  ...........................................................................................................................
	 3.	 How can we move a picture in the presentation?
		  ...........................................................................................................................
	 4.	 What do you mean by formatting?

		  ...........................................................................................................................

Critical Thinking

	 Niharika has made slides on ‘Water Pollution. She forgets to add the 
background to the slides. Suggest to her how to add slides with the 
background.

	 ....................................................................................................................................
	 ....................................................................................................................................

Team Work

	 In the previous chapter, you created 10 slides on ‘Global Warming’ . Now 
add more slides using background and formatting learnt in this chapter.



87 Computer -4

A.	M ultiple Choice Questions. (MCQ)

	 Tick (3) the correct option.
	 1.	 Tabulating Machine was invented by .................. 
			  (a)	 Charles Babbage		  	 (b)	 Blaise Pascal			 
		 (c)	 Herman Hollerith			  	 (d)	 Leibniz				  
	 2.	 It shows a series of commands to access quickly.
			  (a)	 Title Bar	 	 (b)	Delete	 	 (c)	 Rename	 	 (d)	 Move	
	 3.	 We select 3D shapes from the ................
			  (a)	 Ribbon	 	 (b)	3D library 	 (c)	 Text	 	 (d)	 Effects	

B.	 Fill in the blanks with correct words.
	 1.	 Charles Babbage created a mechanical general purpose computer called 

the ..................
	 2.	 A folder serves as ................. for files or at her folders.
	 3.	 The spelling panel appears on the ................. side.
	 4.	 Bulleted list is used when ................. does not matter.

C.	 Write 'T' for True statements and 'F' for False statements.
	 1.	 Sir Charles Babbage is also known as the Father of the Computer.	
	 2.	 After restoring the file will move to its original location.	
	 3.	 Spell and grammar checks make the document error free.	

D.	M atch the following.
				   A				   B
	 1.	 Ctrl+C		  (i)	 Paste
	 2.	 Ctrl+P		  (ii)	 Find and Replace
	 3.	 Ctrl+V		  (iii)	Copy
	 4.	 Ctrl+H		  (iv)	Navigation panel
	 5.	 Ctrl+F		  (v)	 Print preview

Model Test Paper-1
(Based on Chapter 1-4)
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A.	M ultiple Choice Questions. (MCQ)

	 Tick (3) the correct option.
	 1.	 The term is referred to as the background of the stage.
			  (a)	 Canvas			   		  (b)	 Backdrop	
			  (c)	 Workarea		  		  (d)	 Foreground	
	 2.	 In which tab, Save As option is present?
			  (a)	 Format	 	 (b)	 Insert	 	 (c)	 File	 	 (d)	 View	
	 3.	 Making changes in the text’s appearance is reffered to as:
			  (a)	 Formatting		  		  (b)	 Viewing	
			  (c)	 Resizing			  		  (d)	 Moving		

B.	 Fill in the blanks with correct words.
	 1.	 The ................. feature allows to create special text effects.
	 2.	 Purple coloured blocks are ................. blocks.
	 3.	 A collection of many ................. is called a presentation.
	 4.	 Release the ................. once the picture is positioned.

C.	M atch the following.
				   A				   B
	 1.	 Column		  (i)	 Vertical Data
	 2.	 Row			  (ii)	 To combine two or more cells
	 3.	 Merging		  (iii)	To change the size
	 4.	 Splitting		  (iv)	Breaking of multiple cells
	 5.	 Resize		  (v)	

D.	 Fill in the blanks with correct words.
	 1.	 Why is the Word Art feature there?
	 2.	 Name the different blocks available in Scratch.
	 3.	 How can we move a picture in the presentation?
	 4.	 Write the steps to insert a new slide in a presentation.

Model Test Paper-2
(Based on Chapter 5-8)


